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WHAT THIS GUIDE CONTAINS  

This end user guide contains essential information about MyCalls .  It illustrates the use of the 
MyCalls application and then provides steps to customize the application to end user requirements.  

 

WHO SHOULD READ THIS GUIDE  

This guide is for end users of a MyCalls   installation  
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How this manual is organised. 

 

The MyCalls   consists of Call Recorder and Call Manager. Each product is available independently or 

they can be purchased as a complete integrated application. Various features of each product are 

enabled or disabled depending on what aspects of each product have been licensed.  

This manual covers the use of all available features of the products and shows all features available 

but some features may not be available on your installation due to license limitations. 

To improve readability the term MyCalls has been used to refer to one or more of the MyCalls   

products. 
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Chapter 1 

Getting Started with SL MyCalls  

Welcome to MyCalls your comprehensive call management and reporting application. Here in this 
chapter you are introduced to the free to use application, SL MyCalls. A more detailed description of 
the features of SL MyCalls and the fully featured MyCalls Call Manager are described in subsequent 
chapters. Please note that many features are only available with the full MyCalls Call Manager. Full 
details of the licensable options are shown in the appendix at the end of this manual.   

What is SL MyCalls 

SL MyCalls is available as a free to use application. SL MyCalls is an ideal tool for your call 
management, call statistics, costing and reporting tasks. Whilst SL MyCalls will provide a wide range 
of functionality it can be expanded by purchasing MyCalls Call Manager which provides a fully 
comprehensive set of features for the most demanding call management needs. 

Appendix A shows the features available in SL MyCalls and the features available in the MyCalls call 
manager. 

Installed applications 

 

Once installed, you will have access to both the application and a configuration utility. These can be 
accessed via the windows menu under 

NEC Infrontia  -> MyCalls    

The applications are: 

¶ MyCalls ς The main Call Management application 

¶ MyCalls Configuration Import ς Configuration utility 

¶ Collector Configuration ς Configuration utility 

¶ Computer ID Generator and License Manager ς Used for license installation 

Before you can use the applications you will need to run the MyCalls configuration import 
application and configure your system. Refer to the MyCalls installation manual for further 
information. 



Getting Started with SL MyCalls 

 

   Chapter 1-2  
 

Launching MyCalls 

 

MyCalls can be launched by clicking the desktop shortcut or selecting MyCalls from the windows 
menu under NEC Infrontia -> MyCalls. The application will display a default page which includes a 
calls list and statistics windows for Incoming, Outgoing and abandoned calls.  

 
The SL MyCalls Main Screen 

 

Call Lists 

 

 

All MyCalls applications provide call lists in the main display area. Where call recording has been 
installed on its own the standard call log view is available. For MyCalls Call Manager installations the 
additional call views of Unreturned calls, Alarms and Audit Logs are also available. These views share 
the following features 
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View the grid: Positioning the mouse over the appropriate icon in the bottom grid bar will cause 
the window to pop up. 

Pin the Grid: Allows the grid to be fixed in position by selecting the Pin icon to the top right of the 
window. 

 

If the grid is not pinned then it will automatically hide (minimise) when the mouse is not positioned 
over the window. 

The window can be adjusted in height by hovering over and clicking the upper part of the window 
with the mouse and then dragging the window vertically. 

Adjusting the column width: Dragging a column divider with the mouse allows the column to be 
sized horizontally  

Ordering by columnΥ  {ŜƭŜŎǘƛƴƎ ǘƘŜ ŎƻƭǳƳƴ ǘƛǘƭŜ ǿƛƭƭ ŎŀǳǎŜ ǘƘŜ ƎǊƛŘ ǘƻ ōŜ ƻǊŘŜǊŜŘ ōȅ ǘƘŀǘ ŎƻƭǳƳƴΩǎ 
content, e.g. clicking on a number column will sort the contents in ascending numerical order, 
clicking on a name column will sort the items in ascending alphabetical order of the name column. 

Grouping by column: Dragging a column to the grouping area (Drag a column header here to group 
by that column) will group records on that column. To ungroup simply drag the column name 
outside the window. 

 

The screen shot below shows grouping by the date-time column 

 

Column Chooser: Allows the grid to be customized by adding and removing different columns. Top 
add a column select it from the column chooser list and drag it to the grid. To remove a column, drag 
it from the grid and release the mouse button. To move the position of a column, drag the column 
horizontally along the grid. 

Grid View Options 
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Clicking on the options button allows you to display the following options: 
 

 

* My calls only: This displays only calls related to the user currently logged onto the system. 

* All calls for users in my Organisational Group on my PBX: Lists all calls for users in the logged 
ƻƴ ǳǎŜǊΩǎ ƎǊƻǳǇ ōǳǘ ƻƴƭȅ ƛƴŎƭǳŘŜǎ ǘƘƻǎŜ ŜȄǘŜƴǎƛƻƴǎ connected to the local PBX.   

!ƭƭ Ŏŀƭƭǎ ŦƻǊ ǳǎŜǊǎ ƛƴ Ƴȅ hǊƎŀƴƛǎŀǘƛƻƴŀƭ DǊƻǳǇ ŀŎǊƻǎǎ ŀƭƭ t.·ΩǎΥ Lists all calls for users in the 
ƭƻƎƎŜŘ ƻƴ ǳǎŜǊΩǎ ƎǊƻǳǇ irrespective of the PBX the extension is connected to.   

* Custom:  Allows setting of specific period for calls. This can be a date range and can be further 
limited to a specific time period during each day. Extensions, DID filters etc can also be applied. 

Quick Search Filtering: Set the grid filtering using the quick search fields. 

*Only available with the MyCalls manager application 

The Calls View 

The calls visible in the calls view have some special features.  

Call Playback*  

*Only available with the MyCalls manager application 

A speaker icon against a call indicates the call has been recorded, double clicking on the speaker icon 
will playback the call. 

Multiple call legs 

If the call includes transferred legs then the call will have an expansion symbol  
indicating the call can be opened up to reveal the individual legs of the call. 

 



Getting Started with SL MyCalls 

 

   Chapter 1-5  
 

For multi-leg calls a summary call is displayed at the outer level  and each of the legs of the call 
(transfers) at the inner level.  If a summary call has been filtered out (usually by extension) then call 
legs will appear at the outer level and may NOT be grouped together. 

Normal calls without transfers will appear at the outer level . 

 The layout of the call record view is incompatible with versions prior to MyCalls R-3.0.0.0.  This 
means that when upgrading from an earlier version the call record view layout will be set to the 
default layout. 

Using Call Notes*  

*Only available with the MyCalls Manager application. 

Notes can be added to a call and notes do not require call recording in order to be used. To add a 
ƴƻǘŜ ǊƛƎƘǘ ŎƭƛŎƪ ƻƴ ǘƘŜ Ŏŀƭƭ ŀƴŘ ǎŜƭŜŎǘ ΨbƻǘŜǎΩΦ ¢ƘŜ bƻǘŜǎ ŜƴǘǊȅ ŘƛŀƭƻƎ ǿƛƭƭ ōŜ ŘƛǎǇƭŀȅed. You may then 
ǘȅǇŜ ƛƴ ȅƻǳǊ ƴƻǘŜǎ ŀƴŘ ŎƭƛŎƪ Ψ{ŀǾŜΩΦ ! ƴƻǘŜ ŀǇǇƭƛŜǎ ǘƻ ŀ ŎƻƳǇƭŜǘŜ ŎŀƭƭΣ ȅƻǳ Ŏŀƴƴƻǘ ŜƴǘŜǊ ƛƴŘƛǾƛŘǳŀƭ 
notes for each leg of a call. 

Once a note has been added to a call this will be indicated by a notes icon. Double clicking this icon 
will open the note dialog allowing you to add further notes to the call. 

  

Notes are also available as a selectable column from the column chooser. 

Using Quick Search 

 

 

Quick Search fields can be used to search by Number, DID, Extension, Call type, Date/Time. Results 
must meet all criteria in the filter so be careful not to leave anything in the Number box if you are 
only searching for calls related to an Extension as any calls returned in the grid would need to match 
both number and extension. 

Searching for calls using the Notes filters 

 

 

Quick search can also use the notes field. The Note search type can be set to one of the following: 

Matches Filter: Finds all notes where the note contains text matching whatever has been entered 
in the Note Filter textbox. 

Has a note: Finds all calls which have a note attached. 

No Note: Finds all calls with no note attached. 

LŦ ǘƘŜ ŦƛƭǘŜǊ ƛǎ ǎŜǘ ǘƻ ΨaŀǘŎƘŜǎ CƛƭǘŜǊΩ ǘƘŜƴ ǎŜǘ ǘƘŜ ΨbƻǘŜ CƛƭǘŜǊΩ ōƻȄ ǘƻ ǘƘŜ ǎŜŀǊŎƘ ǿƻǊŘ ƻǊ ǇƘǊŀǎŜ ǿƛǘƘƛƴ 
the notes attached to the calls. 
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Max Calls: Limits the number of calls viewable in the grid up to a maximum of 500. It is 
recommended that this is kept to a maximum of 50 calls for normal operation to limit the loading on 
the database. 

Refresh: allows you to manually refresh the calls in the view. 

Unreturned Calls View* 

 

*Only available with the MyCalls manager application 

Unreturned calls are calls where the caller has abandoned and not been called back. The unreturned 
calls are automatically updated when a call is abandoned. Calls are automatically removed from this 
view when either: 

A call is returned 

The same caller calls again and the call is answered 

 

Unreturned calls can be searched using a quick search panel. This quick search allows you to search 

by number, DID, extension and notes 

Unreturned calls can also be displayed in a real time status window ς See Real Time Status 

Exporting Unreturned calls 

Right clicking an unreturned call or multiple unreturned calls allows you to export the list of 

unreturned calls either to a file, clipboard or an email recipient. 

Real time Statistics windows 

MyCalls can display real time statistics within individually configurable colour coded windows. 
Depending on the type of statistics being displayed they may have a number of options available. 

Statistics windows all have the option to lock, refresh and configure using the context menu which is 
viewed by right clicking the mouse whilst hovering over the window.  

Using the mouse you can hover over any real time window and press the right mouse button to get a 
menu of window options. 
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The window menu has the following options available. 

Lock Position 

This allows you to lock a window in place on the screen layout so that it can no longer be re-sized or 
moved.  

 When a window is locked it loses its borders and if you right click on it again you will see a tick next 
to the Lock Position option.  To unlock a window select the Lock Position option again to remove the 
tick and display the windows borders again.  You should now be able to resize and move the 
window. 

 

Refresh Data 

Windows are updated at prescribed intervals  

You can select the refresh data option to force the window to be updated.  

Configure  

This option allows you to configure existing window settings. The actual dialog presented will 
depend on the window tȅǇŜ ŘƛǎǇƭŀȅŜŘΦ  ό{ŜŜ ΨǊŜŀƭ ǘƛƳŜ ǿƛƴŘƻǿ ŎƻƴŦƛƎǳǊŀǘƛƻƴΩ in the chapter on real 
time statistics for more details.) 
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The View Menu 

The MyCalls main screen provides a view menu from which you can select various real time windows 

 

 

Selecting the View-> Real Time Information option allows you to create additional statistics . You can 
choose the following statistics: 

¶ Extension 

¶ DID (DDI) 

¶ Incoming Calls (Trunks) 

¶ Outgoing Calls (Trunks) 

¶ Abandoned Calls (Trunks)  
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Once added to the screen the windows can be placed in any position. Ther are various alignment 
tools available to help you design your screen layout. Full details of how these layouts can be edited 
ŀǊŜ ŘŜǎŎǊƛōŜŘ ƛƴ ǘƘŜ Ψ{ŎǊŜŜƴ [ŀȅƻǳǘΩ ŎƘŀǇǘŜǊΦ ¢ƘŜ [ŀȅƻǳǘ ƳŜƴǳ ǇǊƻǾƛŘŜǎ ŀƴ ƻǇǘƛƻƴ ǘƻ ǊŜǎŜǘ ǘƻ ŘŜŦŀǳƭǘ 
layout however this will delete any new statistics windows you have  

 

! Ŧǳƭƭ ŘŜǎŎǊƛǇǘƛƻƴ ƻŦ ǎǘŀǘƛǎǘƛŎǎ ǿƛƴŘƻǿǎ ŀƴŘ ǘƘŜƛǊ ŎƻƴŦƛƎǳǊŀǘƛƻƴ Ŏŀƴ ōŜ ŦƻǳƴŘ ƛƴ ǘƘŜ ΨwŜŀƭ ¢ƛƳŜ 
{ǘŀǘƛǎǘƛŎǎΩ ŎƘŀǇǘŜǊΦ 

Reporting. 

Reports allow you to analyse your call activity. SL MyCalls provides a number of preconfigured 
reports or alternatively you can create your own reports using the MyCalls report templates. 

SL MyCalls provides a range of preset reports for daily, weekly and monthly activity. These are easy 
to access via the Reports menu. 

The figure below shows the preconfigured reports for daily activity. 

 

 

And the following figure shows the weekly and monthly reports. 
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You can produce your own tailored reports using a MyCalls report template. This allows you to select 
the reporting period(s) and grouping options. The available templates are: 

System Audit 

Lists the audit entries created during the operation of the application 

Call Details 

Shows a list of calls. Each call is itemised separately. Calls can be grouped . For example if you set the 
grouping by extension all calls for each extension appear together. 

Group Summary 

This produces a summary of calls to all Extensions, all DIDs or all Trunks. A single line of statistical 
data is produced showing a summary statistics for the selectŜŘ ŘŜǾƛŎŜ ŜΦƎΦ !ƭƭ 9ȄǘŜƴǎƛƻƴǎΣ !ƭƭ 5L5Ωǎ ƻǊ 
All Trunks. SL MyCalls does not allow user defined groups of devices to be created. 

 Group Summary by Member 

This shows a line of summary statistics for each extension, trunk or DID (depending on the device 
selected).  

Most Frequent calls  

Show the numbers which have been dialled or answered by your business in order of frequency. 

Top Calls 

Provides a list of calls ordered by duration, call cost, handling cost, ring times or held times.  
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Example: Configuring a simple call details report. 

The following example describes how to generate a simple extension call details report for the 
ŎǳǊǊŜƴǘ ǿŜŜƪΦ CƻǊ ƳƻǊŜ ƛƴ ŘŜǇǘƘ ƛƴǎǘǊǳŎǘƛƻƴǎ ƻƴ ŎǊŜŀǘƛƴƎ ǊŜǇƻǊǘǎ ǊŜŦŜǊ ǘƻ ǘƘŜ ΨwŜǇƻǊǘƛƴƎΩ ŎƘŀǇǘŜǊΦ 

 

Firstly you need to access the report wizard. The Report wizard provide a step by step process for 
creating and running a report based on the type of report you wish to create.  Before you start the 
wizard you need to select the appropriate template from the list of report templates. 

Select Report from the main menu. 

/ƭƛŎƪ ƻƴ ΨwŜǇƻǊǘ ¢ŜƳǇƭŀǘŜǎΩ Φ 

Click on Usage and then select Call Details. This will allow you to create a call details report. 

From the right hand list of options ensure Call Details is displayed at the top of the window and 
ǎŜƭŜŎǘ Ψ/ƻƴŦƛƎǳǊŜ ŀƴŘ wǳƴ bƻǿΩΦ 
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The wizard will start. 

{ŜƭŜŎǘ ŀ ǘƛƳŜ ǇŜǊƛƻŘ ǿƘƛŎƘ ǘƘŜ ǊŜǇƻǊǘ Řŀǘŀ ǿƛƭƭ ŎƻǾŜǊΦ Lƴ ǘƘƛǎ ŜȄŀƳǇƭŜ ǿŜ ǎŜƭŜŎǘ Ψ¢Ƙƛǎ ²ŜŜƪΩΦ 

 

 

 



Getting Started with SL MyCalls 

 

   Chapter 1-13  
 

Specify the grouping criteriaΣ ƛƴ ǘƘƛǎ ŎŀǎŜ Ψ9ȄǘŜƴǎƛƻƴΩ. You can also limit the number of calls included 

in the report if required. 

 

Finally specify the call types you wish to include. These can be individually selected from a range of 

incoming, outgoing and abandoned call types. 

 

Click Finish to generate the report. 
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The report will look similar to that shown below.  

 

 

The MyCalls reporting system is quite extensive. The full details for creting and generating the 

ǊŜǇƻǊǘǎ ƛǎ ŎƻǾŜǊŜŘ ƛƴ ǘƘŜ ŎƘŀǇǘŜǊ ƻƴ ΨwŜǇƻǊǘƛƴƎΩ Φ¢ƘŜ {[ aȅ/ŀƭƭǎ ŘƻŜǎ ƴƻǘ ƛƴŎƭǳŘŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ 

features. 

¶ User created Device Groups 

¶ Filters (e.g. report on specific extensions or only show calls over 10 minutes etc). 

¶ Custom Report fields. 
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Chapter 2 
MyCalls Call Manager 

Logging into MyCalls 

MyCalls Manager is the fully licensed Mycalls product. The Mycalls Manager supports multiple users 
and therefore you will need to log in to the system.  

Logging into the system as a user requires that users with appropriate user types and passwords 
have been set up during the configuration of the application. For more details on this see the 
ΨhǊƎŀƴƛǎŀǘƛƻƴ ǎŜǘǘƛƴƎǎΩ ǎŜŎǘƛƻƴΦ 

Normally a user will be associated with a default extension. If this is not the case then you will be 
prompted to select your normal extension as detailed below.  

 

 

How To: Log into the system 

/ƭƛŎƪ Ψ¦ǎŜǊΩ ŀƴŘ ǘƘŜƴ ΨLoginΩ 

 

Type in ŀ ƴŀƳŜ ƛƴ ¦ǎŜǊ bŀƳŜ ŀƴŘ ǘȅǇŜ ƛƴ ŀ ǇŀǎǎǿƻǊŘΣ ŀƭǘŜǊƴŀǘƛǾŜƭȅ ŎƭƛŎƪ ΨBrowseΩ ǘƻ ǎŜŀǊŎƘ ŦƻǊ ŀ 
name 
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Click ΨhYΩ 

Quick tip:  

!ǘ ƭŜŀǎǘ ƻƴŜ t.· ŀŘƳƛƴƛǎǘǊŀǘƻǊ Ƴǳǎǘ ōŜ ŘŜŦƛƴŜŘ ƛƴ ǘƘŜ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƻǘƘŜǊǿƛǎŜ ȅƻǳ ŎŀƴΩǘ 
create or alter any other user.  

 

Selecting your extension when logging on to MyCalls Call Manager 

 

MyCalls Call Manager offers users a hot-desk facility. This enables a user to log onto any extension of 
their choice. Users must be specifically enabled for hot-desking otherwise they will be restricted to 
their default extension. In addition, extensions enabled for hot desking will appear in the list of 
available extensions as well as any extensions for which the user is marked as the default user when 
the user logs on to MyCalls   

 To Summarise: 

¶ Only Users enabled for Hot Desking can select an extension other than their default 

¶ Any  Extensions enabled for Hot Desking will appear in the list of available extensions when 
ƭƻƎƎƛƴƎ ƻƴ ŀǎ ǿŜƭƭ ŀǎ ǘƘŜ ŜȄǘŜƴǎƛƻƴǎ ŦƻǊ ǿƘƛŎƘ ǘƘŜ ǳǎŜǊ ƛǎ ǘƘŜ ΨŘŜŦŀǳƭǘΩ ǳǎŜǊ 

 

Once the hot desking options have been enabled for both users and extensions then the user will be 
presented with the extension list whenever they log on. 
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The user should select the extension that they wish to control which will then be the extension 
controlled from the call control toolbar etc. 

Users can be enabled for hot desking in the user configuration and extensions can be enabled for hot 
desking in the extensions configuration. 
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Chapter 3 

MyCalls Call Recorder 

The MyCalls system provides access to call recordings using the calls list on the front screen. From 
the calls list you can see at a glance any calls which have been recorded and you can playback these 
calls simply by clicking the call playback icon. 

Enabling Users for Call Playback 

Any MyCalls user can be enabled for call playback. Once users have been created then anyone 
logging into MyCalls as a user will have certain rights and restrictions dependent on their user type 
and where they appear within the organisational hierarchy. 

The steps required to ensure call recording can take place for a given set of users are as follows: 

¶ Create your users and user groups* 

¶ Assign each user with a Role 

¶ Assign your users to their respective organisational groups 

¶ Assign each user a default extension 

¶ Enable the user for Call-Recording 

¶ Configure any Call-Recording rules 

The rules governing the playback of calls 

 Any users that are created and want to play back calls must be enabled for call playback 

A normal User can listen to their calls only 

A Supervisor can listen to any calls within their organisational group and any sub group 

A PBX Administrator can listen to any calls on their PBX  

An Enterprise administrator can listen to any calls on all PBXs 

*A Wallboard user can not listen to any calls 

(*Only applies when call manager is installed) 

The above rules can be overridden by applying call recording rules to Callers, Users, Extensions, 
Trunks, DIDs and call types.  

To ensure call recordings are only visible to users with appropriate permissions it is important to 
setup the organisational hierarchy correctly.  In the example below, the highest level group is called 
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Office admin and in that group, there is a Supervisor (Mark).  The supervisor can playback any calls 
from office admin and customer service. 

The Supervisor in customer service (Sarah) however, can only playback calls in the customer service 
group. 

 

 

For the Hierarchal user structure to work correctly, the users must be assigned to extensions.  To 
assign a user to an extension, go to configure / telephone system and edit an extension. The user is 
only assigned to calls on that extension from the time the extension is assigned to them. 

How to: Enable a User for playback 

1) In Configure -Ҕ hǊƎŀƴƛǎŀǘƛƻƴ ŎƭƛŎƪ ΨCreate Neǿ ¦ǎŜǊΩ ƻǊ ΨEdit an Existing UserΩ 

 

2) To give a user the ability to playback calls, check ǘƘŜ ΨEnable Call PlaybackΩ ōƻȄ 

3) ¢ƻ ƎƛǾŜ ǘƘŜ ǳǎŜǊ ǘƘŜ ŀōƛƭƛǘȅ ǘƻ ŜȄǇƻǊǘ Ŏŀƭƭǎ ŎƭƛŎƪ ΨEnable Export of RecordingsΩ 

4) Click ΨOKΩ to save any changes. 

 

*For more details on users and groups see the Organisation configuration section 

Restricting Call Playback 

To enable or disable the recording of certain types of calls or calls made to or from certain parts of 
your organization you can define recording rules. These rules enable or disable specific devices, 
users and call types from being recorded. This allows you to override the normal rules governing 
users as described above. However recording rules cannot enable a user to listen to a wider range of 
calls than their position in the organisation allows. For example a user can only ever listen to their 
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own calls however you could specifically disable calls on an extension within a group from being 
recorded.   

How To: Configure Call Recording Rules 

1) From the menu select - Configure -> Telephone system -> PBX -> Call 

Recording  

2) SŜƭŜŎǘ ǘƘŜ ΨEdit Call RecorderΩ /ƻƴŦƛƎǳǊŀǘƛƻƴ 

3) ¢ƘŜ Ψ9Řƛǘ /ŀƭƭ wŜŎƻǊŘŜǊǎΩ ǿƛƴŘƻǿ ǿƛƭƭ ōŜ ŘƛǎǇƭŀȅŜŘ ς ǎŜƭŜŎǘ ǘƘŜ ΨeditΩ ōǳǘǘƻƴ ŦƻǊ ǘƘŜ ǊŜŎƻǊŘŜǊ ŦƻǊ 
which you wish to set rules 

4)  
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5) From the Ŏŀƭƭ ǊŜŎƻǊŘƛƴƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ǇŀƎŜ ŎƭƛŎƪ ΨRecording RulesΩ 

 

6) The Recording Rules dialog is displayed and you can define rules for enabling or disabling calls. 

 

7) Extensions, DIDs, Callers, Trunks and Users can all be included or excluded from being recorded 
as required.  
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How to: Set up recording rules for Extensions 

  

1) Add devices to tƘŜ ΨSelectedΩ list ōȅ ǎŜƭŜŎǘƛƴƎ ǘƘŜƳ ƛƴ ǘƘŜ ΨAvailableΩ ƭƛǎǘ and clicking    

2) CƘƻƻǎŜ ΨDo not record the selected devicesΩ ƻǊ ΨOnly record the selected extensions.Ω    

You can also decide to include incoming only, outgoing calls only or both. 

Using the Call Playback Interface 

Once logged into MyCalls the calls list will provide access to the recorded calls. The leftmost column 
of the calls list provides an Icon to indicate the call recording status. 

Ψbƻ LŎƻƴΩ ƛƴŘƛŎŀǘŜǎ ǘƘŜǊŜ ƛǎ ƴƻ ǊŜŎƻǊŘƛƴƎ ŦƻǊ ǘƘŀǘ call 

Ψ! Ǉƭŀƛƴ ǎǇŜŀƪŜǊ ƛŎƻƴΩ ƛƴŘƛŎŀǘŜǎ ŀ ǊŜŎƻǊŘƛƴƎ Ƙŀǎ ōŜŜƴ ƳŀǘŎƘŜŘ ǘƻ ǘƘŜ Ŏŀƭƭ 

 

Ψ! ƎǊŜȅŜŘ ƻǳǘ ǎǇŜŀƪŜǊ ƛŎƻƴΩ ƛƴŘƛŎŀǘŜǎ ŀ ǊŜŎƻǊŘƛƴƎ Ƙŀǎ ōŜŜƴ ƳŀǘŎƘŜŘ ǘƻ ǘƘŜ Ŏŀƭƭ ōǳǘ ǘƘŜ ǊŜŎƻǊŘƛƴƎ Ƙŀǎ 
been disabled 

 

 Ψ! ǎǇŜŀƪŜǊ ƛŎƻƴ ǿƛǘƘ ŀ ǊŜŘ ŎǊƻǎǎΩ ƛƴŘƛŎŀǘŜǎ ŀ ǊŜŎƻǊŘƛƴƎ has been matched to the call but the user is 
barred from playing back the call 

 

Ψ! ǎǇŜŀƪŜǊ ƛŎƻƴ ǿƛǘƘ ŀ ǊŜŘ ŎǊƻǎǎ ŀƴŘ ŀ ƎǊŜŜƴ ŀǊǊƻǿΩ ƛƴŘƛŎŀǘŜǎ ǘƘŜ Ŏŀƭƭ ƛǎ ŀ ǘǊŀƴǎŦŜǊǊŜŘ ƛƴŎƻƳƛƴƎ ŎŀƭƭΣ ŀ 
recording has been matched to the call but the user is barred from playing back at least part of the 
call 

 

How To: Select and Playback a call 

1) From the ΨviewΩ ƳŜƴǳ select ΨCall Records ViewΩ ƻǊ ǎŜƭŜŎǘ Ψ/ŀƭƭǎΩ ŦǊƻƳ ǘƘŜ ǘƻƻƭōŀǊ ŀǘ ǘƘŜ ōƻǘǘƻƳ 
left side of the screen: 
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2) By default the call records view will display the last 50 calls for the current day.  Calls that have 
been recorded will show a speaker icon meaning they have been recorded.   

3) To play a call that has been recorded, simply double click the speaker icon   located in the far 
left box to play the call. 

 

 

 

4) After you have double clicked the speaker, the player will load and play the call. At the same 
time the new call will be added to the playlist. 

5) The currently playing call or call leg is displayed in Red. 

6) Right clicking on the calls view will also allow you to playback a call by selecting the Playback Call 
item from the menu. 

 

Multiple call selection 

You may select several calls from the calls view listing.  

To select a range of call click on the first call required from the list and then hold down the shift key 
and click on the last call required. All calls between the first and last calls will be selected.  
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To select several individual calls click on each call whilst holding down the Ctrl key. 

  

 

The Call Player 

MyCalls provides a Call Control player specifically designed for call recording and playback. The 
player provides the following functions 

¶ Play/Stop 

¶ Fast forward/Rewind 

¶ Overall Volume 

¶ Adjust relative volume between each call participant   

¶ Change speed of playback without affecting pitch to clarify what was said 

¶ Create selections and store as sound clips 

¶ Set the start and endpoints of a selection as either a time or via mouse selection 

¶ Loop round selections or complete calls 

¶ View transfers as separate sections of a call 

¶ Navigate between sections of a call  

¶ Play next and previous sections of a call 

¶ Create playlists of complete calls 

¶ Play next/previous call in playlist 

¶ Create notes for calls 

¶ Auditing of playback and export activity 

¶ Export of audit logs 

¶ Export of calls 
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Feature Configuration 

You may not have all the features of the player available. The call player feature configuration is 
determined by the license as follows. 

 

 Waveform 

Display 

Sound 
clips 

Section 
markers 

Single 
call 
recording 
export 

Bulk call 
recording 
export 

Volume, 

Balance, 

Playback 
Speed 

Call 
Audit 

Basic    V     

Enhanced V  V  V   V  V   

Enhanced+Audit V  V  V   V  V  V  

 

Call Playback 

When a call is selected for call playback it is added to the playlist. Double clicking the speaker icon 
from the call records list launches the player and commences call playback. Control of playback is via 
the playback buttons. 
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Call Player Waveform 

 

 

The call player can display a waveform representing the recorded call. This option is licensable and 
only available with the enhanced call player.  If the product is licensed as a basic configuration then a 
compressed waveform window will be visible but no actual waveform trace will be shown. With the 
enhanced player a full two channel waveform is visible. 

When a call is played a yellow cursor line will move across the waveform window indicating the 
position of the playback point. The cursor also displays the elapsed time in minutes and seconds 
from the start of the call. If the call length is greater than 1 hour then hours and minutes will be 
shown. 

 

The bottom of the waveform window shows the time base of the call and this is scaled automatically 
to match the call length.  

The player can playback the whole call or selected parts of the call. Whether you are using the player 
in basic or enhanced configuration selections can be made from the waveform window in the same 
way. 

How To: Make a selection in the waveform window 

To make a selection from the waveform window simply click and drag the mouse along the 
waveform window.  

The selected area will show up as a grey block. 

 Release the mouse and the selection will be displayed along with a selection control bar which 
appears as a white line with a grab handle at either end of the selection.  

Selecting the control bar in the centre will allow you to move the selection left or right.  

Selecting either of the grab handles will allow you to adjust the start or end point of the selection 
independently. 

Clicking within the selection but away from the selection control bar causes the playback cursor to 
move to the mouse position.  
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Basic Player showing selection but no waveform 

¢ƻ ŎŀƴŎŜƭ ŀ ǎŜƭŜŎǘƛƻƴ ǎƛƳǇƭȅ ǊƛƎƘǘ ŎƭƛŎƪ ǘƘŜ ǎŜƭŜŎǘƛƻƴ ŀƴŘ ǇƛŎƪ Ψ/ŀƴŎŜƭ {ŜƭŜŎǘƛƻƴΩ ŦǊƻƳ ǘƘŜ ŎƻƴǘŜȄǘ 
menu. 

 

 

Creating a sound clip (Enhanced player only) 

Once you have created a selection it can be turned into a sound clip. Sound clips can be named and 
are automatically saved into a sound clip list when they are created. 

How To: Create a new sound clip 

¢ƻ ŎǊŜŀǘŜ ŀ ƴŜǿ ǎƻǳƴŘ ŎƭƛǇ ǊƛƎƘǘ ŎƭƛŎƪ ŀ ǎŜƭŜŎǘƛƻƴ ŀƴŘ ǎŜƭŜŎǘ Ψ!ŘŘ ǘƻ ǎƻǳƴŘ ŎƭƛǇǎΩ ŦǊƻƳ ǘƘŜ ŎƻƴǘŜȄǘ 
menu.  

This will ǇƭŀŎŜ ǘƘŜ ǎƻǳƴŘ ŎƭƛǇ ƛƴǘƻ ǘƘŜ ǎƻǳƴŘ ŎƭƛǇǎ ƭƛǎǘ ǿƛǘƘ ŀ ŘŜŦŀǳƭǘ ƴŀƳŜ ƻŦ ΨbŜǿ /ƭƛǇΩΦ   

The name of the clip is displayed in the waveform window so each clip is easily identifiable.  

¢ƘŜ ƴŀƳŜ ƻŦ ǘƘŜ ŎƭƛǇ Ŏŀƴ ōŜ ŎƘŀƴƎŜŘ ŦǊƻƳ ǘƘŜ ΨǎƻǳƴŘ ŎƭƛǇǎ ƭƛǎǘΩ ōȅ ǎŜƭŜŎǘƛƴƎ the name of the clip and 
ǘȅǇƛƴƎ ǘƘŜ ƴŜǿ ƴŀƳŜ ƻǾŜǊ ǘƘŜ ǎŜƭŜŎǘŜŘ ǘŜȄǘ όǎŜŜ ΨǎƻǳƴŘ ŎƭƛǇ ƭƛǎǘΩ ǎŜŎǘƛƻƴύΦ 

 

 A sound clip can be selected and manipulated just like a normal selection by right clicking over the 
ǎƻǳƴŘ ŎƭƛǇ ŀƴŘ ǎŜƭŜŎǘƛƴƎ ά{ŜƭŜŎǘ ΨbŜǿ /ƭƛǇΩέ ŦǊƻƳ the menu (New clip is replaced with the name of 
the clip to be selected see below). 

  

Selecting a new clip 
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{ŜƭŜŎǘƛƴƎ ŀ ŎƭƛǇ ƴŀƳŜŘ ΨLƴǘǊƻΩ 

To delete a sound clip right click the sound clip waveform and select Delete [Clipname] from the 
menu. 

 

 

Enhanced player with full waveform and multiple sound clips 

 

Exporting Audio 

 

The waveform window provides a mechanism to export the call audio to either WMA or WAV file 
format. Right clicking on any part of the window will give you the option to export the whole call. 

 

Right clicking on a selected area of the call will allow you to export the selection. 

 

 

Calls can also be exported directly from the Calls View list on the main MyCalls screen. 
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If you have created a sound clip then right clicking the sound clip allows you to export the sound clip 
as a WMA or WAV file. Sound clips can be exported from the sound clips grid using mouse right click 
ŀƴŘ ǎŜƭŜŎǘƛƴƎ Ψ9ȄǇƻǊǘ ǎƻǳƴŘ ŎƭƛǇΩ ŦǊƻƳ ǘƘŜ ƳŜƴǳΦ 

  

 

Call audio can be exported by using the right-click menu in the following locations: 

¶ Main call list 

¶ Any Playlist 

¶ Sound Clip list 

¶ Waveform window 

{ŜƭŜŎǘƛƴƎ ŜƛǘƘŜǊ Ψ9ȄǇƻǊǘ /ŀƭƭ !ǳŘƛƻΩΣ Ψ9ȄǇƻǊǘ {ŜƭŜŎǘƛƻƴΩ ƻǊ Ψ9ȄǇƻǊǘ ǎƻǳƴŘ ŎƭƛǇΩ ƻǇŜƴǎ ŀ ŘƛŀƭƻƎ ōƻȄ ŀƴŘ 
you can choose where to save the file and select the format. The default filename is determined by 
ǘƘŜ Ŏŀƭƭ ǊŜŎƻǊŘƛƴƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ ¢ƘŜ ŦƛƭŜ ŦƻǊƳŀǘ Ŏŀƴ ōŜ ǎŜƭŜŎǘŜŘ ŦǊƻƳ ǘƘŜ Ψ{ŀǾŜ ŀǎ ǘȅǇŜΩ ŘǊƻǇ Řƻǿƴ 
box. 

 

 

You can export audio for single calls or multiple calls. To export multiple calls simply select the 
required calls from the calƭǎ ǾƛŜǿ ƻǊ ǇƭŀȅƭƛǎǘΣ ǊƛƎƘǘ ŎƭƛŎƪ ƻƴ ǘƘŜ ǎŜƭŜŎǘƛƻƴǎ ŀƴŘ ŎƭƛŎƪ Ψ9ȄǇƻǊǘ /ŀƭƭ !ǳŘƛƻΩΦ 
When exporting multiple calls the dialog will be slightly different as shown below and export 
progress will be visible in the status bar for each call (the status is also visible for single calls but only 
usually visible on longer calls). 
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Multiple selection export dialog 

 

 

Export Status 
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Playback Controls 

 

 

 

The playback controls are as follows: 

¶ Play/Stop: operates the playback of the call, click to start playback, click again to pause, 
playback will then continue from that point.  

¶ Rewind: Click and hold will rewind the cursor, single click will set the cursor back at the state 
of the call. 

¶ Fast Forward: Click and hold to fast forward the call. 

¶ Previous Section/Next Section: Calls contain various sections as follows: 

¶ Ring: This is at the start of the call and is determined from the ring duration 

¶ Answer: This is the main part of the call 

¶ Transfer: This is determined when a call is transferred to another extension 

NB: The sections of a call are determined from values within the SMDR and may not be available on 
all telephone switches. An option is available in the call recording configuration (see call recording 
configuration) to disable call sections, in which case these buttons are greyed out indicating they are 
disabled (as in the picture above). 

Waveform Enable: Enables or disables the display of the waveform. Disabling the waveform allows 
you to quickly scroll through a playlist without having to wait for the waveform display to update 
between each call selection. 

Loop Enable: Allows you to loop a complete call or a selection. 

Playlist controls: These buttons allow navigation of the playlist items and sound clip items (see 
playlist and sound clips section). 
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Call Player Management Panel 

 

 

The call player management panel allows you to manage Playlist, Sound Clips, Notes and Audits. 
Select the type of item you wish to manage from the tabs below. 

 

Playlists 

Playlists contain a list of calls selected from the main call records list. A playlist will remain in the 
player as long as the MyCalls client application is running. When a call is selected and played it is 
added to the current playlist. Calls can be added to the playlist using one of the following methods: 

¶ Double click the speaker icon 

¶ wƛƎƘǘ ŎƭƛŎƪ ƻƴ ǘƘŜ Ŏŀƭƭ ŀƴŘ ǎŜƭŜŎǘ ΨtƭŀȅōŀŎƪ /ŀƭƭΩΣ ǘƘƛǎ ǿƛƭƭ ŀǳǘƻƳŀǘƛŎŀƭƭȅ Ǉƭŀȅ ǘƘŜ Ŏŀƭƭ ŀǎ ǿŜƭƭ 

¶ wƛƎƘǘ ŎƭƛŎƪ ƻƴ ǘƘŜ Ŏŀƭƭ ŀƴŘ ǎŜƭŜŎǘ Ψ!ŘŘ ǘƻ ǇƭŀȅƭƛǎǘΩ 

¶ Click and drag a call from the call records to the playlist. The player needs to be open in 
order to use this method. 

Only calls with a valid speaker icon can be added to the playlist.  

/ŀƭƭǎ Ŏŀƴ ōŜ ǊŜƳƻǾŜŘ ŦǊƻƳ ǘƘŜ Ǉƭŀȅƭƛǎǘ ōȅ ǊƛƎƘǘ ŎƭƛŎƪƛƴƎ ǘƘŜ Ŏŀƭƭ ǿƛǘƘƛƴ ǘƘŜ ƭƛǎǘ ŀƴŘ ǎŜƭŜŎǘƛƴƎ ΨwŜƳƻǾŜ- 
{ŜƭŜŎǘŜŘΩ ŦǊƻƳ ǘƘŜ ŎƻƴǘŜȄǘ ƳŜƴǳΦ  

Calls which contain multiple transfers (multi leg calls) are shown with a plus symbol next to the call. 
Clicking on the plus symbol expands the call and allows you to select a specific call-leg. 

 

You can see in detail which extensions have participated in the call and how long each leg of the call 
lasted. 

Selecting either the main call record or any leg of the call will cause that call to be loaded into the 
player and played back from the start of the call. The currently selected call or call-leg is displayed in 
red. 
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Right clicking a call in the playlist gives the following options 

Export Call Audio: In the same way as selecting this option from the waveform menu 

Copy: Copies the call details to the clipboard for pasting into a document or report 

Select All: Select all calls in the list 

Export to File/Clipboard/Email: exports the contents of the selection to a text file, clipboard or email. 
Email recipients must be configured into the application. 

Remove Selected, Remove all: Remove items from the playlist. 

Sound Clips 

 

 

 

Any sound clips which have been created are listed under the sound clips tab. Each sound clip can 
have a name, description, start and end point, and a colour. There is also an option to show or hide 
the clip in the waveform window. 

Sound clips are associated with a specific call and will remain in the list until the associated call is 
deleted from the playlist. 

How To: Edit Sound Clip Details 

{ƛƴƎƭŜ ŎƭƛŎƪ ƻƴ ǘƘŜ ΨbŀƳŜΩΣΩ 5ŜǎŎǊƛǇǘƛƻƴΩΣΩ .ŜƎƛƴΩ ƻǊ Ψ9ƴŘΩ ŎƻƭǳƳƴ ŦƻǊ ǘƘŜ ǎƻǳƴŘ ŎƭƛǇΦ  

This will select the sound clip within the waveform window and select the text or time value for 
editing. 

For text columns Name and Description simply enter the text required. For Begin and End times 
enter the times required.  

Colour selection can be changed for a sound clip by clicking on the colour column and selecting a 
new colour from the palette. 
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Notes 

A note can be added to a call either in the playlist or from the call record view. The notes can be 
viewed by selecting the Note tab within the player. Any changes to the notes must be saved by 
clicking the save button. 

The Created by, Created date and Last modified by fields are automatically populated based on the 
logged in user. 

Audits 

It is useful to know what has happened to a particular call after it has been recorded. The MyCalls 
playback audit system logs events associated with the following aspects of a call recording: 

¶ Playback: Logs activity every time a call is played back 

¶ Export: Logs all call export activity 

¶ Clip: Logs Sound clip creation, name changes, deletion. 

¶ Configuration Changes: Logs changes to the call recorder configuration 

Each Audit record is read only and contains the following information: 

¶ Start/Finish date and times of the audited activity. 

¶ Audit Type: Identified the type of activity e.g. Playback. 

¶ User: The logged on user who carried out the activity. 

¶ Description: A pre-defined description of the activity. 

Additional Controls 

Two other panels are available with additional controls.  

Selection and Sound control start and end times can be adjusted using the Begin/End controls 

Play Selected range/Sound Clip limits playback to the currently selected area of the waveform panel 
or the currently selected sound clip. 

Auto Move to Next Call causes the player to automatically load and play the next call in the playlist 
once the current call has finished playing. 

 

 

 

Volume: Adjusts overall volume of the player. 

 Balance: Adjust the relative volume between the recording channels of the internal and external 
party can be adjusted.  

Playback Speed: Where 1X is normal playback speed and can be adjusted faster or slower + or ς  
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Finding Recorded Calls 

For fast retrieval of calls for playback you can use the quick search from the calls grid options.  Quick 
search is the easiest way to find a call by CLI, DID, Extension or Note-text.   

Quick Search 

From the ΨviewΩ menu, click ΨCall record viewΩ.  The quick search is highlighted below; by default it 
ǎƘƻǿǎ ǘƘŜ ƭŀǎǘ рл Ŏŀƭƭǎ ŦƻǊ ǘƻŘŀȅΦ  ¢ƻ ŎƘŀƴƎŜ ǘƘŜ ŘŀǘŜ ǘƻ ǎŜŀǊŎƘ ƻƴΣ ǎŜƭŜŎǘ ŦǊƻƳ ǘƘŜ ƭƛǎǘ ƛƴ ǘƘŜ ΨPeriodΩ 
drop down menu.  To enter specific dates, choose custom and enter your dates and times as 
required.   

The next line down allows you to search for a particular telephone number, DID and extension. You 
can enter partial numbers to search on e.g. 01270 would find any number containing ΨлмнтлΩΦ 
Entering both a Number, DID and an Extension will search for calls containing all items in the one 
call.   

You can also search using the notes field. The Note search type can be set to one of the following: 

Matches Filter: Finds all notes where the note contains text matching whatever has been entered in 
the Note Filter textbox. 

Has a note: Finds all calls which have a note attached. 

No Note: Finds all calls with no note attached. 

You can also choose which call types to include and the maximum number of calls to display. 

 

If you cannot see the quick search, click ΨoptionsΩ ƛƴ ǘƘŜ Ŏŀƭƭ ǊŜŎƻǊŘǎ ǾƛŜǿ ŀƴŘ ǎŜƭŜŎǘ ΨQuick SearchΩ 
from the options. 

Having found the call or calls of interest you can add the call to the current playlist or create a new 
playlist by double clicking the speaker icon for that call. For more information on playlists see the 
playlist section. 
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Recordings which you cannot listen to 

Calls that show a speaker icon crossed out means the calls has been excluded from call recording in 
the recording rules configuration. 
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Call Recording Configuration 

Trunk Configuration 

Configuration of call recording requires the correct configuration and licensing of trunks. Whilst this 
should be taken care of during the system installation, it is possible that the call recording 
configuration could change at some point due to licensing of additional trunks.  

In order to enable recording on specific trunks they will need to be assigned as call recording trunks 
within the call recording configuration. 

Access to the Call Recording configuration 

How to: Access the Call-Recording configuration screen 

1) From the menu select - Configure -> Telephone system -> PBX -> Call 

Recording  

2) {ŜƭŜŎǘ ǘƘŜ ΨEdit Call RecorderΩ /ƻƴŦƛƎǳǊŀǘƛƻƴ 

3) The Edit Call recorders window will be displayed 

 

The Call recorder configuration screen allows the setting up of call recorder units, Licensing of 
Trunks and the editing of call recorder settings and recording rules.  
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How To: Add Call Recorders to the MyCalls Configuration 

1) To add a new Ŏŀƭƭ ǊŜŎƻǊŘŜǊ ŎƭƛŎƪ ǘƘŜ ΨAdd Call RecorderΩ ōǳǘǘƻƴΦ ¢ƘŜ ǿƛƴŘƻǿ ōŜƭƻǿ ǿƛƭƭ ŀǇǇŜŀǊΦ  

 

2) Select the call recorder type from the drop down menu, and enter a name e.g. Crompton Road. 

3) /ƭƛŎƪ ΨOKΩ 

4) ¢ƘŜ Ŏŀƭƭ ǊŜŎƻǊŘŜǊ ǿƛƭƭ ƴƻǿ ŀǇǇŜŀǊ ƛƴ ǘƘŜ ΨLƴǎǘŀƭƭŜŘ /ŀƭƭ wŜŎƻǊŘŜǊǎΩ section 

 

5) {ŜƭŜŎǘ ǘƘŜ ǊŜǉǳƛǊŜŘ Ŏŀƭƭ ǊŜŎƻǊŘŜǊ ŀƴŘ ŎƭƛŎƪ ΨEditΩ 

6) The Call recording configuration screen will be displayed 
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Recording Server Name: Enter the name of the call recording PC  

Playback Port, Archive Port, Playback Speed: These do not normally require changing 

Test Connection: Press this button to check the call recording PC is responding 

  

Additional Configuration options 

 

 

File export settings. 

Default Filename Prefix: Defines the file naming for exported files. This can be freetext combined 
with pre defined identifier names. Any identifier name must be surrounded by % characters with no 
spaces. MyCalls will substitute an identifier with the appropriate value for example %user% will 
substitute the logged on user name, %Date% will insert the current Date etc. 

How To: Insert an identifier into the filename prefix 

Set the cursor at the position in the prefix where you want to insert the identifier. In this example we 
have set the cursor at the end of the prefix. 
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The available identifiers are available by clicking the  button. This will display the list of 
identifiers.  

Select the identifier and the new identifier will be added to the prefix. 

 

The prefix will now be pre-pended to the filename whenever a call recording file is exported. 

 

 

Enable Transfer Leg Navigation 

This option enables the ability to display the identification of transfer legs in the waveform window. 

Trunk Licensing 

Whilst trunk licensing is an installation operation, it may be necessary for a system administrator to 
adjust or configure additional channels of call recording.  

The call recorder is licensed to record a certain number and type of channels based on what the 
customer has bought. In order to know which of the channels are to be used, the trunks in MyCalls 
need to be set to the correct type and marked for inclusion in call recording.  

Only trunks that are marked as ISDN or AN4009 are listed. Trunks that are either BRI or PRI need to 
be marked as ISDN within MyCalls 

Trunks that are analogue need to be marked as Analogue within MyCalls 

Remaining licenses for each type of trunk are indicated to the right of the Trunk Licensing grid. 

Licensed trunks need to be associated with the appropriate call recorder. If only one call recorder is 
installed then selecting a licensed trunk checkbox will automatically select the call recorder. If there 
are more than one call recoder then you will need to select the call recorder for each trunk. 
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Backup Call Recordings 

Call recordings can and should be backed up to an area that can be taken off-site for security 
purposes. The call recordings when backed up are still encrypted and can only be played using the 
MyCalls system. The backup can be scheduled to occur at set times and split into different volume 
sizes for storage on to CD or DVD. The split volumes create a new directory for each split and 
increment a number at the end of the volume name to ensure they are unique. 

Once call recordings have been archived the system can remove the actual recording from the 
computer. If you wish to play back a call recording that has been archived and deleted from the 
system you will be instructed to insert the disk that hold the archived call recording. The system will 
then restore that call recording and can then be replayed. 

How To: Configure Call Recording Backups 

1) Select the Recording Backup button from the Call Recorder Configuration Dialog. 

 

2)  
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3)  

4) The backup folder MUST be one that is local (attached) to the call recording server. 

 

How To: Manually Start a Call Recording Backup 

1) Select the Recording Backup button from Configure Call Recording Backup Dialog. 

2) Enter the dates for the backup to apply to and press the Backup button. 

3)  

 

How To: Cancel a Running Call Recording Backup 

1) Select the Recording Backup button from the Configure Call Recording Backup Dialog. 

2)  

3) Press the Cancel Running Backup, This will instruct the call recording server to cancel any 
scheduled or manually started backups that are currently running. 
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Chapter 4 

MyCalls Screen Layout 

 

The Main Display 

The main screen for MyCalls can display any combination of real time information windows you wish 
to create in any position. In addition to real time windows you can also view call logs and other 
information from the Grid Bar at the bottom of the screen.   

 

Common features of real time information windows 

The windows visible on the MyCalls main screen are individually configurable. Depending on the 
type of screen they may have a number of options available. 
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Status and statistics screens all have the option to lock, Refresh and configure using the context 
menu which is viewed by right clicking the mouse whilst hovering over the window.  

Using the mouse you can hover over any real time window and press the right mouse button to get a 
menu of window options. 

 

The single parameter window menu has the following options available. 

Lock Position 

This allows you to lock a window in place on the screen layout so that it can no longer be re-sized or 
moved.  

 When a window is locked it loses its borders and if you right click on it again you will see a tick next 
to the Lock Position option.  To unlock a window select the Lock Position option again to remove the 
tick and display the windows borders again.  You should now be able to resize and move the 
window. 

 

Refresh Data 

Data is automatically taken from the database at prescribed intervals  

You can select the refresh data option to force the data of the window to be updated. This will force 
a retrieval of the data. 

Configure  

This option allows you to configure existing window settings. The actual dialog presented will 
ŘŜǇŜƴŘ ƻƴ ǘƘŜ ǿƛƴŘƻǿ ǘȅǇŜ ŘƛǎǇƭŀȅŜŘΦ  ό{ŜŜ ΨǊŜŀƭ ǘƛƳŜ ǿƛƴŘƻǿ ŎƻƴŦƛƎǳǊŀǘƛƻƴΩ ŦƻǊ ƳƻǊŜ ŘŜǘŀƛƭǎΦύ 
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The View Menu 

The MyCalls main screen provides a blank area onto which you can arrange various real time 
windows. In addition to the Real Time windows you can also view popup windows to allow easy 
access to the various logs which are recorded within the MyCalls database. These Log windows 
include Calls, Unreturned calls, Alarms and Audit logs. 

To access the log windows you can either select from the View menu where you will see selection 
checkboxes to show or hide the various log windows. Selecting either Call Records, Unreturned Calls, 
Alarms or Audit Log makes the associated window visible on the screen. 

 

In addition to the logs you can also enable the viewing of the main toolbar below the main menu at 
the top of the screen 

 

The Grid bar at the bottom of the screen 

 

The Status window found at the bottom of the screen. 
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Chapter 5 

Screen Layouts 

Introduction to Layouts 

Layouts are the view of MyCalls call manager that you see when you run the application. A layout is 
made up of pages. A page contains a particular arrangement of parameter windows and can be 
stored under a specific page name as part of a layout. Changes to the arrangement of a given page is 
automatically stored and recalled when the application is closed and reopened. 

Layouts (along with their pages) can be saved as public layouts.  

Pages are normally arranged so that parameter windows relating to a particular set of information 
can be grouped and viewed together without the screen becoming overburdened with unnecessary 
information. This is especially useful if for example you want to create a grouped view of 
departmental statistics.   

Other elements of a layout which you can customize are the toolbars displayed on screen.  You can 
choose to hide or display the main toolbar, grid or status bars.  The MyCalls window can be 
repositioned on your Call Control and resized so that the next time you open the application it 
recalls these settings and positions itself accordingly.    

 

Public and Local Layouts 

Local layouts are views that you create on your local machine. They viewed only on the computer on 
which they were created   
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To share your layout with other users you need to save it ŀǎ ΨǇǳōƭƛŎΩ ƛƴ ŀ ƭƻŎŀǘƛƻƴ ŀŎŎŜǎǎƛōƭŜ ōȅ ƻǘƘŜǊ 
users in the MyCalls database. Should you wish to share the layout with users on other sites or 
create a layout for general distribution then you can save the layout to a disk file. Agent Desktop 
users cannot open public Layouts or create their own layouts as they have a layout pre-assigned to 
them. 
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How To: Saving a public layout 

1) You can save screen layouts as public layouts in either the MyCalls database or to an external 
file.  This means that other users can load it and use it as a starting point to create their own 
layout. 

2) When you have finished configuring your layout as you want it be viewed, from the Layout menu 
ǎŜƭŜŎǘ ΨSave PublicΩΦ 

 

3) You have two options for saving your layout.  You can either save it in the MyCalls database or 
you can choose a location on your computer or network and save it as a layout file (.lay file 
extension). 

4) To save to the MyCalls ŘŀǘŀōŀǎŜ ǎŜƭŜŎǘ ǘƘŜ ƻǇǘƛƻƴ ΨSave to databaseΩ ŀƴŘ ǘƘŜ [ŀȅƻǳǘ bŀƳŜ ŘǊƻǇ 
down list will become active.  Enter a new name for your layout to be identified by the system.  
If you wish to overwrite an existing layout in your database then select an existing item name 
from the list. 

5) ¢ƻ ǎŀǾŜ ȅƻǳǊ ƭŀȅƻǳǘ ǘƻ ŀƴ ŜȄǘŜǊƴŀƭ ŦƛƭŜ ǎŜƭŜŎǘ ǘƘŜ ƻǇǘƛƻƴ ΨSave to external fileΩ ŀƴŘ ǘƘŜ [ŀȅƻǳǘ 
bŀƳŜ ŦƛŜƭŘ ōŜƭƻǿ ǿƛƭƭ ōŜŎƻƳŜ ŀŎǘƛǾŜΦ  9ƴǘŜǊ ŀ ǇŀǘƘ ƛƴǘƻ ǘƘŜ ŦƛŜƭŘ Ƴŀƴǳŀƭƭȅ ƻǊ ŎƭƛŎƪ ǘƘŜ Ψ.ǊƻǿǎŜΩ 
button to select a location to save your file to.  Enter a name for your file in the File Name field 
as shown in the image below and theƴ ǇǊŜǎǎ ǘƘŜ ΨSaveΩ ōǳǘǘƻƴ ǘƻ ǊŜǘǳǊƴ ǘƻ ǘƘŜ {ŀǾŜ {ŎǊŜŜƴ 
Layout window. 

6) ²ƘŜƴ ȅƻǳ ƘŀǾŜ ŜƴǘŜǊŜŘ ǘƘŜ ǊŜǉǳƛǊŜŘ ƛƴŦƻǊƳŀǘƛƻƴ ǘƻ ǎŀǾŜ ȅƻǳǊ ƭŀȅƻǳǘ ǇǊŜǎǎ ΨOKΩ 

 

Once saved a layout can be reopened and used as the current layout. Opening a public layout simply 
creates a local copy of the layout which you are then at liberty to change. The changes you make to 
your local copy do not affect the original public layout in any way.  

How To: Opening a Public Layout 

1) You can load a public layout that a user has saved to either the MyCalls database or an external 
file.  Opening a layout will permanently overwrite your current screen layout.  All user types 
except AGENT DESKTOP users can open public layouts. 

2) If you are not a AGENT DESKTOP user then you can open a previously saved Public Layout from 
either a server or client machine. 

3) CǊƻƳ ǘƘŜ [ŀȅƻǳǘ ƳŜƴǳ ǎŜƭŜŎǘ ǘƘŜ ƻǇǘƛƻƴ Ψ[ƻŀŘ tǳōƭƛŎΩ. 
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4) The Load Screen Layout window will be displayed.  If there are layouts saved in the MyCalls 
database then the Load from database will be selectable but if there are not then you can only 
load a layout from an external file. 

 

5) In the Layout Name field manually enter the file path to the layout you want to load or 
ŀƭǘŜǊƴŀǘƛǾŜƭȅ ǳǎŜ ǘƘŜ ΨBrowseΩ button to locate the file from your computer or network location 
ŀǎ ǎƘƻǿƴ ōŜƭƻǿ ǳǎƛƴƎ ǘƘŜ ΨOpen dialogΩΦ 

6) ²ƘŜƴ ȅƻǳ ƘŀǾŜ ƭƻŎŀǘŜŘ ǘƘŜ ƭŀȅƻǳǘ ŦƛƭŜ ǇǊŜǎǎ ǘƘŜ ΨOpenΩ ōǳǘǘƻƴ ǘƻ ǊŜǘǳǊƴ ǘƻ ǘƘŜ [ƻŀŘ {ŎǊŜŜƴ 
[ŀȅƻǳǘ ǿƛƴŘƻǿ ŀƴŘ ǘƘŜƴ ǇǊŜǎǎ ǘƘŜ ΨOKΩ ōǳǘǘƻƴ ǘƻ ƭƻŀŘ ǘƘŜ ƭŀȅƻǳǘ ƛƴǘƻ ǘƘŜ MyCalls window. 

You can also delete public layouts if required. This only affects the public layout and has no impact 
on any other layouts which may have used this public layout in the past.  

How To: Deleting a Public Layout from the Database 

1) You may delete a screen layout from the MyCalls database so that it can no longer be loaded by 
other users.  Users that have previously loaded a layout before it is deleted will not be affected. 

2) To remove a saved public layout from the MyCalls database, select from the Layout Menu the 
ƻǇǘƛƻƴ ΨDelete PublicΩΦ 

3) You will be displayed with the Delete Screen Layout window. 

 

4) From the Layout Name drop down list select the name of the saved layout you want to delete. 

5) tǊŜǎǎ ΨOKΩ ǘƻ ŘŜƭŜǘŜ ǘƘŜ ƭŀȅƻǳǘ ŦǊƻƳ ǘƘŜ ŘŀǘŀōŀǎŜΦ  ¸ƻǳ ǿƛƭƭ ōŜ ǇǊƻƳǇǘŜŘ ǘƻ ŎƻƴŦƛǊƳ ǘƘŜ ŘŜƭŜǘƛƻƴ 
process, to confirm press ΨYesΩ ƻǊ ǘƻ ŎŀƴŎŜƭ ǇǊŜǎǎ ΨNoΩΦ 

Agent Desktop users have very limited access to MyCalls features and have no control over the 
layout. An Agent Desktop will be assigned a layout by the supervisor and that layout will appear on-
screen as soon as the application is launched and the agent has logged in. 
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How To: Assign a Public Layout to an Agent Desktop User 

1) You can assign screen layouts to Agent Desktop users.  This means that the next time these users 
log on, they will view the layout assigned to them.  The Agent Desktop users are unable to 
modify the layout. 

2) To assign a layout to an Agent Desktop ǳǎŜǊ ǎŜƭŜŎǘ ǘƘŜ ΨAssignΩ option from the Layout menu. 

3) The Assign Screen Layouts screen will be displayed.  

 

4) Using the Layout Name drop down list you can select the name of the screen layout you want to 
assign to the Agent Desktop users. 

5) In the Assigned Users field you will see a list of all the Agent Desktop users configured within 
MyCalls.  You can assign the currently selected layout to the users by clicking the box to the left 
ƻŦ ǘƘŜ ǳǎŜǊΩǎ ƴŀƳŜΦ  ¢Ƙƛǎ ǿƛƭƭ ǘƘŜƴ ŘƛǎǇƭŀȅ ŀ ǘƛŎƪ ǘƻ ǎƘƻǿ ǘƘŀǘ ǘƘŜ ǳǎŜǊ ƛǎ ŀǎǎƛƎƴŜŘ ǘƘŜ ŎǳǊǊŜƴǘƭȅ 
selected layout.  You can remove the tick from a user to de-assign a screen layout from them. 

6) tǊŜǎǎ ΨhYΩ to save the assign layout selection to the Agent Desktop users. 

Layout Pages 

Pages are the main component of a screen layout.  They enable you to display real time window 
information and arrange it in a way that best suits your organization.   

 

You can switch between saved pages of a layout by using the drop down list of pages within the 
main toolbar 
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 Creating New Pages  

How To: Creating new Pages 

1) CǊƻƳ ǘƘŜ ƭŀȅƻǳǘ ƳŜƴǳ ǎŜƭŜŎǘ ΨtŀƎŜǎΩ ŀƴŘ ŎƭƛŎƪ ǘƘŜ ΨbŜǿΩ option. 

2) You will be prompted to provide a name for your new layout page.  Enter a name and click the 
ΨOKΩ button. 

 

3) Your new page will now have been created and now be displayed on screen.  The page will have 
been added to the layout page selection tool in the main toolbar. 

 

4) You can now modify the page as per your requirements with real time window parameters 
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Deleting Pages 

How To: Delete Pages 

1) Select a layout page you want to delete using the layout page selection tool on the main toolbar. 

 

 

2) CǊƻƳ ǘƘŜ ƭŀȅƻǳǘ ƳŜƴǳ ǎŜƭŜŎǘ ǘƘŜ tŀƎŜǎ ǎǳō ƳŜƴǳ ŀƴŘ ǘƘŜƴ ŎƭƛŎƪ ΨDeleteΩ  

3) You will be ŀǎƪŜŘ ǘƻ ŎƻƴŦƛǊƳ ǘƘŜ ŘŜƭŜǘƛƻƴ ƻŦ ǘƘŜ ŎǳǊǊŜƴǘƭȅ ǎŜƭŜŎǘŜŘ ǇŀƎŜΦ  tǊŜǎǎ ΨYesΩ ǘƻ ŎƻƴŦƛǊƳ 
ǘƘŜ ŘŜƭŜǘƛƻƴ ƻǊ ΨNoΩ ǘƻ ŎŀƴŎŜƭ ǘƘŜ ǇǊƻŎŜǎǎΦ 

4) The page will now have been deleted and removed from the layout page selection tool on the 
main toolbar. 

 Save All Pages 

How To: Save all Pages 

If you have been making a number of modifications to different pages in your layout you can save 
ǘƘŜ ǿƻǊƪ ȅƻǳ ƘŀǾŜ ŘƻƴŜ ŀŎǊƻǎǎ ŀƭƭ ǇŀƎŜǎ ōȅ ŎƭƛŎƪƛƴƎ ǘƘŜ Ψ{ŀǾŜ !ƭƭΩ ƻǇǘƛƻƴ ƛƴ ǘƘŜ tŀƎŜǎ ǎǳō ƳŜƴǳ ƻŦ 
the layout menu. 

 Copying Pages 

How To: Copy pages 

1) You may wish to create a page that is similar to an existing page you have available.  To cut 
down the time it takes to setup a page layout you can use the Copy Page feature in the Pages 
sub menu of the layout menu. 

2) You will be prompted to provide a name for your copied layout page.  Enter a name and click the 
ΨhYΩ button. 

 

3) A copy of your existing page will now be displayed and available from the layout page selection 
tool.  This new page should have the name you previously provided and you can alter existing 
settings to your requirements. 
 

 Reloading Pages 
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How To: Reload Pages 

1) If you have made significant changes to a layouts page, but decide that you preferred the pages 
the way they were before, then you can revert them back to their previous state so long as you 
have not saved the changes in the meantime. 

2) CǊƻƳ ǘƘŜ ƭŀȅƻǳǘ ƳŜƴǳ ǎŜƭŜŎǘ ǘƘŜ ΨtŀƎŜǎΩ ǎǳō ƳŜƴǳ ŀƴŘ ǘƘŜƴ ŎƭƛŎƪ ƻƴ ǘƘŜ ΨwŜƭƻŀŘΩ option. 

3) Your pages will now be restored to their previous saved state without any unsaved changes you 
have made since. 

 View Screen as Agent Desktop User 

How To: View screen as an Agent Desktop User 

1) You can view your screen as an Agent Desktop ǳǎŜǊ ǿƻǳƭŘ ǎŜŜ ƛǘ ōȅ ŎƘƻƻǎƛƴƎ ǘƘŜ ΨView as Agent 
Desktop optionΩ ŦǊƻƳ ǘƘŜ tŀƎŜǎ ǎǳō ƳŜƴǳ ƻŦ ǘƘŜ [ŀȅƻǳǘ ƳŜƴǳΦ 

2) This will remove any real time window control boxes and lock the windows on the screen as they 
are positioned. 

3) To come out of the Agent Desktop view in order to move and re-size real time windows you can 
ǎŜƭŜŎǘ ǘƘŜ ΨRestore from Agent Desktop viewΩ ŦǊƻƳ ǘƘŜ ΨtŀƎŜǎΩ ǎǳō ƳŜƴǳ ƻŦ ǘƘŜ Ψ[ŀȅƻǳǘΩ ƳŜƴǳΦ 

Resetting Installation Defaults 

How To: Reset to installation defaults 

1) If for whatever reason, you have got to the point where you wish you could start over again, you 
can. 

2) CǊƻƳ ǘƘŜ [ŀȅƻǳǘ ƳŜƴǳ ǎŜƭŜŎǘ ǘƘŜ ƻǇǘƛƻƴ ΨwŜǎŜǘ ǘƻ Lƴǎǘŀƭƭŀǘƛƻƴ 5ŜŦŀǳƭǘΩ ŀƴŘ ǘƘƛǎ ǿƛƭƭ ǊŜǎŜǘ ŀƭƭ ȅƻǳǊ 
layouts and pages back to how they were when the application was first installed. 
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Automatic viewing of multiple pages 

Having created a multiple page layout you can then view a single page using the drop down menu on 

the main toolbar. 

 

Alternatively by setting up a display sequence you can automatically display each page. The pages to 

be displayed are added into a display sequence. Your sequence can contain any or all of the pages 

you have created and they can be displayed in any order. There is also a timer for each page in the 

sequence so that you can vary the amount of time a particular page remains on screen. 

Set up the sequence as follows 

How To: Create a playback Sequence 

1) CǊƻƳ ǘƘŜ ƭŀȅƻǳǘ ƳŜƴǳ ǎŜƭŜŎǘ Ψ{ŎǊŜŜƴ [ayout Pages->Display Sequence  

 

 

 

2) Using the displayed dialog select each page you wish to display from the available pages list. As 
you select each page click the select Ą button to add the page to the selected pages list.  
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3) For each page in the selected pages list you can change the number of seconds the page is to be 
displayed for. You can also alter the order in which the pages are to be displayed using the move 
up and move down buttons. 

4) To remove a page from the list click the deselect ă button  

5) When you have made your selections click OK 

6) You can view the pages now by clicking the play icon from the main menu as shown below. 
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Tools to help you layout your pages 

As seen in the previous chapter each page within a layout can be populated with various windows 
e.g. incoming calls, outgoing calls. These windows can contain statistical information, graphs, web 
content and other forms of data. To help us arrange this content on our pages MyCalls provides a set 
of alignment and sizing   tools. Initially you will need to create the windows to be placed on the page.  
Once you have your windows on the page you can change their positions and sizes. 

Manual alignment and sizing 

Any window placed on a page may be positioned by simply clicking and dragging the window to the 
new position. The windows can be resized by clicking on the frame of the window and dragging the 
ǿƛƴŘƻǿΦ /ƭƛŎƪƛƴƎ ƻƴ ǘƘŜ ǎƛŘŜ ƻŦ ŀ ǿƛƴŘƻǿ ǿƛƭƭ ŀƭƭƻǿ ȅƻǳ ǘƻ ŜȄǇŀƴŘ ǘƘŜ ǿƛƴŘƻǿΩǎ ǿƛŘǘƘ ŀƴŘ ŎƭƛŎƪƛƴƎ 
on the top or bottom of a window will allow you to expaƴŘ ǘƘŜ ǿƛƴŘƻǿΩǎ ƘŜƛƎƘǘΦ /ƭƛŎƪƛƴƎ ƻƴ ŀ ŎƻǊƴŜǊ 
of a frame will allow the window to be expanded in both directions at once. 

Selecting multiple windows 

In order to align or resize multiple windows we must select the required windows on screen. To 
select multiple windows simply hold down the control (Ctrl) key on your keyboard and click on the 
windows you wish to include in the selection. Each window will be highlighted with a border. When 
multiple windows are selected the ΨŦormat menuΩ will be enabled. The automatic alignment and 
sizing tools operate on the first window selected, this means that if you were aligning two windows 
to the left, then both windows would align to the first selected window. 

Automatic alignment and sizing 

Several automatic alignment and sizing tools are available for you to use when designing your page 
layouts.  These tools are located on the top toolbar or can be accessed via the ΨŦormat menuΩ.  
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The format menu and the alignment tools (shown above) are disabled unless multiple windows are 
selected.  The options available are as follows. 

Alignment: 

Align Windows left: Align all selected windows to the left hand edge of the first selected window 

Align Windows Right: Align all selected windows to the right hand edge of the first selected window 

Align Windows Top: Align all selected windows to the top edge of the first selected window 

Align Windows Bottom: Align all selected windows to the bottom edge of the first selected window 

Align Centres Horizontally: Align selected windows along the horizontal axis 

Align Centres Vertically: Align selected windows along the vertical axis 

Sizing: 

Make heights equal: Set all selected windows to the same height 

Make widths equal: Set all selected windows to the same width 

Make heights and widths equal: Set all selected windows to the same width and height 

Distribution: 

Make horizontal spacing equal : Space the selected windows equally across the width of the screen 

Increase horizontal spacing: Increase the distance between selected windows across the screen 

Decrease Horizontal spacing: Decrease the distance between selected windows across the screen 

Remove horizontal spacing: Remove spacing between selected windows across the screen 

Make vertical Spacing equal: Space the selected windows equally across the width of the screen  

Increase vertical spacing: Increase the distance between the windows top to bottom  

Decrease vertical spacing: Decrease the distance between the windows top to bottom 

Remove vertical spacing: Remove the spacing between the windows top to bottom 
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Chapter 6 
Real Time Statistics 

Real Time Statistics Windows 

Real time statistics allow you to calculate a wide range of statistical values for all the devices, users 
and groups. The groups can either be predefined system groups or user defined.  The system groups 
are automatically created and devices are assigned to these system groups according to the device 
type e.g. Digital Desk Phones. User defined groups are created by the application users according to 
how the devices and users are used in the organisation e.g. Sales, Accounts. 

Statistical periods and calculations 

Statistics can be calculated in various ways depending on how you want to view your data. Each of 
the statistics windows allow you to select the period over which the statistics are calculated.  

Historical statistics 

These statistics are calculated differently depending on how you select the period. 

Daily: calculates a daily accumulated value or average which is reset each day at midnight. 

Hourly: Calculates accumulated or averaged statistics for each hour of the day. All values are reset 
at midnight.  

Current statistics 

Last Hour: These values are calculated as a rolling statistic over the previous 1 hour period, for 
example if the time is currently 14:30 then the current value calculated will be that value between 
13:30 and 14:30 

Types of Real Time Statistics window 

There are four types of real time statistics accessible via the real time information menu; Real Time 
Statistics (Grid View) windows, Single Value windows, Combination value and miscellaneous 
windows. 
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Real time statistics (Grid View) windows display a user defined selection of statistics for one or more 
devices or groups. 

Single value windows show an individual statistic in either a Numerical or Graphical format. 

Combination value windows show comparative statistics of different statistics on the same graph. 

Miscellaneous windows can display external data from XML, Database and other data sources and 
live web pages. 

Grid View Statistics windows:  

Select View -> Real Time Information -> Real Time Statistics from the MyCalls menu. 

This type of window allows you to view many statistics in the minimum screen area. You can 
configure group or individual statistics grid views. 

 

Real time statistics displayed in the grid view allows you to display cumulative call statistics on users, 
DIDs, extensions, DID groups, extension groups and trunk groups.  Statistics included by default 
include answered calls, abandoned calls, grade of service and abandoned grade of service although 
more fields are available to be added to the view if required. 

Daily/ Hourly Single Value windows:  

Single value windows provide numeric or graphical windows showing single value statistics based 
around Call Rate and Performance. Call Rate windows display numerical values only whereas 
performance statistics can display results as numerical values or graphical values. To show these 
ǇŀǊŀƳŜǘŜǊǎ ŀǎ ŀ ƴǳƳŜǊƛŎŀƭ ǾŀƭǳŜ ǎŜƭŜŎǘ ǘƘŜ Ψ{Ƙƻǿ {ƛƴƎƭŜ ±ŀƭǳŜΩ ƛƴ ǘƘŜ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ǿƛƴŘƻǿΦ 
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Numerical values appear as a single coloured window showing the parameter value and other 
associated information such as Title, Group, and the Interval over which the statistic is calculated 
e.g. daily, hourly. 

Call Rate statistics show the cumulative counts for the various call types and you can elect to 
display these values over both historical (daily, hourly) periods and current (last hour) periods. 

Call Performance statistics are either cumulative totals e.g. number of long calls, or average 
values e.g. average wait time.  

The cumulative total statistics can only display values numerically and you can select both historical 
and current calculation periods. 

The Average value statistics can be displayed in both numeric and graphical format and the 
statistical period is limited to either Ψ5ŀƛƭȅΩ ƻǊ Ψнп IƻǳǊΩ ƻǇǘƛƻƴǎ. If you elect to display the values in 
ƴǳƳŜǊƛŎŀƭ ŦƻǊƳŀǘ ȅƻǳ ǿƛƭƭ ƴŜŜŘ ǘƻ ǎŜƭŜŎǘ ǘƘŜ Ψ{Ƙƻǿ {ƛƴƎƭŜ ±ŀƭǳŜΩ /ƘŜŎƪōƻȄ ƛƴ ǘƘŜ ŎƻƴŦƛƎǳǊŀǘƛƻƴ 
screen* and this option is only be available for the daily period.  

*See detailed configuration later in this section. 

 
Numerical View of average wait time statistic   

The graphical output displays the Min/Max values for the parameter as a bar and the average value 
is shown as a line graph over the 24 hour period. 
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Graphical view of Average Wait Time 24 hour  

Unreturned calls real time windows 

The unreturned calls operate differently to other real time statistics windows in that they can be 

displayed as a list format showing all unreturned calls currently active or they can be displayed as a 

single value window showing a total number of currently unreturned calls. 

You can create an unreturned calls window for each device type allowing you to show the 

unreturned calls for a specific group of devices such as extensions, DIDs etc. 

How To: Create an unreturned calls real time window 

Select View->Real Time Information->Single Value 

Select the type of device group you wish to filter the unreturned calls on so if you want to see all the 
unreturned calls coming into a group of DIDs then select DID groups -> call rate-> unreturned calls. 

Select Single Value or Call List depending on the display type you require  

Set the Interval period either to Last 24 hours or today which shows calls from midnight previous. 

Select the device group either system or user created group 

Click OK 
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Real time calls window configuration dialog 

The resulting windows look as follows: 

 Unreturned calls single value window 

 

Unreturned calls list window 
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Combination Value windows:  

Combination value windows provide graphical representation showing call volume histograms and 
the maximum and minimum number of calls mapped against average values. 

Combination values can only be displayed for historical statistics i.e. daily and 24hour and can 
display min/max bar charts for each hour and a line graph overlay showing the average values over 
time. 

 

 

Moving the mouse over the graph will show the Average and Min/Max values in a context window. 

 

 

The Combination values work best when looking at and comparing different call types such as 
Outgoing and Incoming calls. 

 


